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INTRODUCTION 

This guide provides an overview of the spectrogram application Sonic Visualiser. 

It outlines the basic features of the software and the recommended settings for engaging with 
the suite of Visualising Vocal Sound multimedia resources and activities created for the 
PRESTO project. 

This open-source application was developed by a research team at the Centre for Digital Music, 
Queen Mary University of London.  

To download the application, go to the Sonic Visualiser website. For a more detailed reference 
manual produced by the creators of the application, click here. 

Reference:  
Chris Cannam, Christian Landone, and Mark Sandler, Sonic Visualiser: An Open Source 
Application for Viewing, Analysing, and Annotating Music Audio Files, in Proceedings of the 
ACM Multimedia 2010 International Conference. 

https://c4dm.eecs.qmul.ac.uk/
https://c4dm.eecs.qmul.ac.uk/
https://www.sonicvisualiser.org/download.html
https://www.sonicvisualiser.org/doc/reference/4.5/en/
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1. What is Sonic Visualiser?

Sonic Visualiser is a free, cross-platform application developed by a team at the Centre for 
Digital Music, Queen Mary University of London and designed to be a user-friendly tool for 
anyone who wants to    see sound as well as hear it. 

Audio can be played back, recorded, and explored within the application. All visual 
representations of sound are displayed in on-screen windows called ‘Panes’. 

1.1 What is a Spectrogram? 

A spectrogram is a visual representation of sound frequencies – or pitches – displayed in 
Hertz Frequency values (Hz) over a period of time measured in seconds and milliseconds. 
These snapshots of sound are displayed in a graph-like form with pitches read vertically and 
time read horizontally: 

Audio can be recorded directly into Sonic Visualiser and converted into a spectrogram 
image. Alternatively, an audio file can be opened within the application.  

For more, see: 
5. Recording Audio; 6.  Opening Audio Files; 7.  Converting  Audio  to  Spectrograms.

https://c4dm.eecs.qmul.ac.uk/
https://c4dm.eecs.qmul.ac.uk/
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1.2 What is an Audio Waveform? 

An audio waveform is a visual representation of sound amplitude amplitude – or loudness – 
over a period of time, and provides information about changes in energy in the sound: 

The waveform will automatically appear on the screen when audio is recorded directly 
into Sonic Visualiser or when an audio file is opened. From there, the waveform can be 
converted to a spectrogram (see 7. Converting Audio to Spectrograms). 

2. What do I need to use Sonic Visualiser?

To get started, you need: 

- a personal computer or laptop running Sonic Visualiser.

The software can be downloaded here. The application is suitable for machines 
running Windows, Mac, or Linux operating systems. Sonic Visualiser is not mobile 
or tablet compatible. 

- an external USB microphone attached to your computer.

This is optional but be aware that computer noise (e.g., cooling fan or another programme 
running in the background) will cause noise to be captured when recording into the 
application. This will be visible in the converted spectrogram image: 

https://www.sonicvisualiser.org/download.html
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Spectrogram recorded without USB 
microphone. Noise from the computer 
causes a visible line across the top of the 
spectrogram and a grainy image. However, 
spectrographic detail is still visible. 

Spectrogram recorded with a USB 
microphone. The image is sharper, and the 
spectrographic detail is clearer. 

For best results, it is recommended that a USB microphone be used when demonstrating 
concepts and interacting with spectrograms in a live context, e.g., online, in a large teaching 
room, a studio or rehearsal space. 

3. Opening Files

3.1 Opening Sonic Visualiser 
Sonic Visualiser opens on a blank window or ‘Pane’ and is automatically ready for use. 

To open an audio file for listening and converting to a spectrogram inside the application, use 
one of the following options: 

3.2 Opening an Audio File 
Go to File Menu >> Open and find audio file on computer (.wav, .mp3, etc). 

OR 

 and find audio file on the computer or drive (.wav, .mp3, etc.)  Click on the Open File 
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3.3 Opening an existing Sonic Visualiser file 

Sonic Visualiser files will be saved with the extension .sv.  

To open an existing Sonic Visualiser file: 

Go to the File Menu >> Open and find file (e.g., Tenor_note D.sv) 

OR 

Click on the Open File icon  and find audio file on the computer or drive

(e.g., Open Vowel_note D.sv) 

Alternatively, Right-click/Ctrl-click .sv file and choose ‘Open with Sonic Visualiser’. 

3.4 Reopening a Sonic Visualiser File 

If reopening* a file used quite recently, use the shortcut option: File >> Open Recent and a list 
of recent files will appear. Click on the required file. 

*User Note: if an audio file has been deleted or moved to another location on the
computer since last used with the Sonic Visualiser application, the file pathway will be broken
and will not open using this shortcut option. If this happens, use one of the File Menu >>
Open options above.

4. Tools and Functions in Sonic Visualiser

There are lots of menus and tools available for use in Sonic Visualiser. See a complete list 
in the full reference manual here for details. The main Tools needed when engaging 
with spectrograms and the activities within the PRESTO project are outlined below: 

4.1 File Menu 

This menu is used for opening, saving, importing, and exporting audio. It is also 
accessed when saving spectrograms and exporting spectrogram images for use in printed 
or virtual documentation. For more information, see: 5. Recording Audio, 6. Opening 
Audio Files, 9. Saving Files, 10. Exporting Files.

https://www.sonicvisualiser.org/doc/reference/4.5/en/
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4.2 Transport Bar 

This bar contains buttons for recording and playback of audio files and spectrograms: 

1. 2. 3. 4. 5. 6.

1. Rewind to Start: this rewinds the audio waveform or spectrogram back to the
beginning of the file.

2. Rewind in Steps: clicking this button will rewind the audio waveform or spectrogram 
back by incremental steps of time (10 seconds each time).

3. This is the Play and Pause button. Click once to play an audio waveform file or 
spectrogram. Click again to pause playback (Shortcut: click the Spacebar to begin/pause 
playback).

4. Fast Forward in Steps: clicking this button will fast forward the audio waveform or 
spectrogram back by incremental steps of time (10 seconds each time).

5. Fast Forward to End: this places the cursor at the end of the audio waveform or 
spectrogram.

6. Record. Press this button to begin recording an audio file. Press again to stop the 
recording.

4.3 Main Toolbar 

The main toolbar controls how a user can interact with an audio waveform or 
spectrogram. Each icon button provides access to different function:   

1. 2. 3. 4. 5. 6.
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The main functions for use with audio waveforms and spectrograms are: 

1 Navigate Tool: Click and drag to move the audio waveform or spectrogram to the left 
or right on the screen. 

2. Select Tool: This is used to select parts of an audio waveform or spectrogram. Click 
and drag to make a selection.

This Tool works in conjunction with the Constrain Playback to Selection Tool also found 
on the main application toolbar:            (See 4.4.1 below). 

Other Tools include: 

3. Edit Tool: for moving items around in editable Layers. See 4.5 Layer Menu below.

4. Draw Tool: for adding items to editable layers.

5. Erase Tool: for deleting items from editable layers.

6. Measure Tool: for analysing unit data.

See the full reference manual for more information on Tools. 

4.4 Additional Tools on Main Toolbar 

4.4.1 Constrain Playback to Selection 

When this Tool is on, only the selected portion of the audio waveform or spectrogram 
will play back. For more, see Selection in the full reference manual. 

4.4.2 Loop Playback 

When the audio waveform or spectrogram is played in full, the playback cursor will jump back 
to the beginning of the file and repeat playback. The audio waveform or spectrogram will 
continue to play back until the Play/Pause button or Spacebar is clicked. This function also 
applies to a selection when the Constrain Playback to Selection Tool is on (See 4.4.1 above).   

https://www.sonicvisualiser.org/doc/reference/4.5/en/#tools
https://www.sonicvisualiser.org/doc/reference/4.5/en/#selection
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4.4.3 Solo Current Pane 

Clicking on this button allows the user to choose which pane on screen will play back 
when working with two audio waveform files or spectrograms. To highlight which window 
pane will play back, click on the upper or lower window pane. The playback pane will display 
a black line to the left of the window which is active. Click on the Solo Current Pane button 
again to turn this function off. Both panes will now play at the same time. For more, see  
6.2 Importing More Audio. 

4.5 Layer Menu 

There are lots of Layer Tools available within this menu including: 

- a Time Ruler to display the division of time on an audio waveform or spectrogram

- a Boxes Layer for highlighting a specific part of a waveform or spectrogram.

Some of these layers are editable and the Edit Tool (see 4.3 above) can be used 
to move items around on the screen. For a complete list of Tools available, see the 
full reference manual on the Layer Menu. 

The main Layer Tool for working with spectrogram activities in the PRESTO project is 
'Add Spectrogram'. See 7. Converting Audio to Spectrograms for more on using this layer. 

4.6 View Menu 

The View Menu provides lots of tools for viewing audio waveforms or spectrograms. 

The main Functions and Tools for viewing details in spectrograms are: 

        4.6.1 Overlays 

Overlays provide information about the spectrogram. 
Show Minimal Overlays (Shortcut: press number 9): this will display the basic 
spectrogram image with the frequency values to the left of the screen: 

https://www.sonicvisualiser.org/doc/reference/4.5/en/#layerdetails
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Frequency Values  

Show No Overlays (Shortcut: press number 0): this will display the basic spectrogram 
image but without the frequency values to the left of the screen: 

 No Frequency Values  

This function may be useful when displaying the spectrogram image on a small screen. 

4.6.2 Zooming 

Zoom Wheels are located on the bottom right corner of the screen. They allow the user 
to zoom in and out of the spectrogram when highlighting information such as higher 
harmonic detail in the Harmonic Series (see PRESTO Video Resources for more on the 
Harmonic Series and other concepts that can be demonstrated using spectrograms): 
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Zooming in and out of Spectrograms: 

The horizontal wheel will zoom in and out along the time axis* so that the spectrogram will 
expand outwards to display more detail per second. This function is useful when exploring or 
demonstrating individual characteristics such as note onsets, vibrato, consonants interacting 
with vowels, etc. 

The vertical wheel will zoom in and out along the frequency value axis** so that the 
spectrogram will expand outwards to display more detail per frequency value on the left. This 
function is useful when exploring or demonstrating individual characteristics such as 
harmonics, resonances, vowel formants, etc. 

*User Note: As the time axis is zoomed out, less detail will be visible on the screen. (See 6.1 
for information on Playback Settings).

**User Note: As the frequency value axis is zoomed out, less detail will be visible. Use the 
Navigate Tool to move the spectrogram up or down to focus attention on required detail. 
(See 4.3 for more information on the Navigate tool). 

To hide the Zoom Wheels from view, go to View Menu >> Show Zoom Wheels       
(Shortcut: press Z key). 

To fit the waveform or spectrogram to the visual window, go to View >> Zoom to Fit 
(Shortcut: press the F key). 

4.6.3 Property Boxes/Tabs 

Sonic Visualiser automatically creates a global Property Box and 3 Tabs when launched. 
These Tabs will appear on the top right of the screen and contain individual Property Boxes 
with various display settings: 
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 Pane           Ruler       Waveform 

When an audio file is recorded into Sonic Visualiser or opened within the application, the 
colour of the waveform can be changed here. 

When the waveform is converted to a spectrogram, another Tab appears: 

  Pane       Ruler      Waveform   Spectrogram 

For more on suggested settings for using spectrograms with PRESTO activities, see 
7. Converting Audio to Spectrograms.

Each time a new Layer is added, a corresponding Tab will appear in the global Property 
Box, e.g., when a Text Layer is selected, a Text Tab will appear.

Property Boxes can be shown or hidden. Go to the View Menu >> Show Property 
Boxes (Shortcut: press X key) to toggle on or off. This function is useful for hiding 
the boxes when exporting out spectrogram images for printing or use in virtual displays. 
For more information on exporting spectrogram images, see 10. Exporting Files. 

5. Audio Recording

5.1 Basic Recording 

To record into Sonic Visualiser, click on the Record button on the Transport Bar  and 

the recording will begin. To stop recording, click the Record button again or hit the 
spacebar on your keyboard (see 4.2 Transport Bar above). 

5.2 Recording Additional Audio 

Sonic Visualiser will only capture one extract of audio per recording, i.e. the recording 
cannot be paused and continued in the same manner as some audio editing and 
recording software such as Audacity.  

https://www.audacityteam.org/
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If the Record button in Sonic Visualiser is clicked again, a second waveform window 
will appear beneath the first one and capture the sound being recorded.   

6. Opening Audio Files

Sonic Visualiser will open the following audio file formats: .wav, .mp3, .ogg, .aiff, .mp4, .wma.  
To open an audio file for use with the application: 
Go to File Menu >> Open and find audio file on computer (.wav, .mp3, etc) 

OR 

Click on the Open File icon  and find audio file on computer (.wav, .mp3, etc). 

6.1 Playback Settings 

The audio waveform and spectrogram scrolling and playback Tab will automatically be 
visible in the global Property Box when the application is launched (See 4.6.3 
above). Within this Tab, playback can be set to play only a visible page (i.e. screen) at a 
time so that the cursor will jump to the beginning of the next page when it reaches the 
end of the previous page. Click on the Follow Playback drop-down menu and choose ‘Page’: 
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Playback can also be set to scroll continuously until the audio waveform or spectrogram 
has played through. Click on the Follow Playback drop-down menu and choose ‘Scroll’: 

This setting will work in conjunction with the horizontal width of the waveform 
or spectrogram on the screen (i.e. whether it fits the screen, is smaller or larger 
than the screen). This will also depend on zoom settings (see 4.6.2 above). 

Both settings can be turned off by selecting ‘Off’ in the Follow Playback drop-down menu.  

6.2 Importing More Audio 

To compare two audio files side by side, additional audio can be imported into 
Sonic Visualiser. Go to File Menu >> Import More Audio and find the audio file on the 
computer. Note that this audio will appear in a separate window below the existing 
audio file. Both audio waveforms (or spectrograms) will play back at the same time. To 
choose which audio waveform or spectrogram is played back (i.e. toggle playback):  

Click on the Solo Current Pane button:  Highlight which window pane will playback 

by clicking into the upper or lower window pane. The playback pane will display a black band 
to the left of the window: 
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The spectrogram on the top will play 
back and the one on the bottom will be 
silent. 

The spectrogram on the bottom will 
play back and the one on the top will 
be silent. 

To toggle playback off so that both panes will play at the same time, click on the Solo 
Current Pane button again. 

7. Converting Audio to Spectrograms

There are several spectrogram options available within Sonic Visualiser. It is 
recommended that users apply the 'Add Spectrogram' option for exploring vocal sound 
and engaging with the Visualising Vocal Sound activities on the  PRESTO  website. 

To convert an audio file to a spectrogram image, go to Layer Menu >> Add 
Spectrogram (Shortcut: Shift+G).

If working with a stereo audio file, there will be an option to convert both left and 
right channels mixed together or separately. It is recommended that the 
'All Channels Mixed' option is used for demonstrating vocal concepts and exploring the 
visualisation of vocal sound (unless the recorded material has been deliberately panned). 
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If working with a mono recording, the option to mix or display separately will not appear. 
To convert a mono recording to stereo (if required) for use in Sonic Visualiser, import the 
mono audio file into audio editing software such as Audacity, duplicate the mono audio file 
and export it back out as a stereo audio file. Open in Sonic Visualiser and convert to a 
spectrogram as outlined above. 

Other spectrogram options are available from the Layer Menu. See the full reference 
manual for more on the Melodic Range and Peak Frequency spectrograms. 

When the audio waveform file is converted to a spectrogram, a new Spectrogram Tab 
appears in the Property Box to the top right of the screen (see 4.6.3  for more on Property 
Boxes/Tabs):

 Pane       Ruler      Waveform   Spectrogram 

7.1 Recommended Settings for getting the most out of your Spectrograms 

Different settings applied in the Spectrogram Tab help with displaying detail 
within spectrograms. These include colour maps, window size, window overlapping and 
oversampling. 

The following settings are recommended when using Sonic Visualiser for 
Visualising Vocal Sound activities and explorations: 

Select settings are explained below:

https://www.audacityteam.org/
https://www.sonicvisualiser.org/doc/reference/4.5/en/#spectrogram
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7.1.1 Colour 

The colour setting simply changes the colour mapping displayed on the screen. 

Users should explore the options from the drop-down menu to find the best colour setting 
for their needs. The two dials to the left of the menu (Threshold; Colour Rotation) are used to 
fine-tune the colour map selected if required. 

As a guide, and from tests conducted as part of the PRESTO project, it is recommended 
that the following colour settings are applied: 

Sunset 

Green 

best for overhead projector display, printing and use in documentation; 
best overall colour resolution across different computer operating systems 

good for overhead projector display, printing and use in documentation 

Black on White can provide good clarity when displaying Formant detail in vowel shapes 
for printing in black and white or grayscale 

Fruit Salad good for demonstrating Harmonics/Resonance; displays better on 
smaller screens but will work with overhead projector depending on detail 
within the spectrogram  

7.1.2 Window Size 

This setting determines the resolution of the spectrogram in terms of frequency and time. 
Smaller numbers will provide a finer resolution of the image in terms of time value;            
Larger numbers will provide a finer resolution of the image in terms of frequency value.  

The default setting is '1024'. This can be increased using the drop-down menu. 
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Increasing this number to '2048' will return a finer resolution across frequency values 
in the spectrogram image. Values above '2048' usually result in a blurring of the 
spectrogram image when working with vocal sound. 

7.1.3 Window Overlap 

This setting relates to the portion of the display pane (i.e. the spectrogram image) that 
will overlap when processing the audio waveform file and displaying it as a 
spectrogram. The default is 50% which generally works well when the default Window 
Size setting is selected, '1024'. 

When using a larger window size, '2048' for example, it is better to apply a 
higher percentage such as 75% to compensate for the amount of material being analysed 
by the programme. This will help sharpen the image. 

7.1.4 Oversampling 

This setting helps with smoothing out the resolution of the spectrogram. The default setting 
is '1x' which works well with the default Window size. Using a figure of '2x' helps 
with achieving clarity of image when applying a larger Window Size. 

8. Comparing Spectrograms

One way of comparing spectrograms is to open both audio files and convert to 
spectrograms. See 6. Opening Audio Files, 6.2 Importing More Audio, and 
7. Converting Audio to  Spectrograms for details.

A second way of comparing spectrograms is to record two audio files and convert them 
to spectrograms for comparison.  

Sonic Visualiser captures only one extract of audio per recording. Once the first recording 
has been captured, click on the Record button again, record audio, and a second waveform 
window will appear beneath the first one, displaying the captured audio. Convert both audio 
waveforms to spectrograms.  
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Both spectrograms may be played simultaneously or one at a time. Use the Play Solo toggle 
button to play the selected spectrogram. For more on Recording, see: 5. Recording  Audio. 
For more on Play Solo toggle button, see: 4.4.3 Solo Current Pane and 6.2 Importing 
More Audio. 

9. Saving Files

To save a Sonic Visualiser file for future use, go to File Menu >> Save Session As, name the file 
and save it to the computer or drive location (Shortcut: Ctrl+S /Shift+Cmd+S  ). 

To export the .sv file as a spectrogram image or audio file, see 10.         Exporting         Files below. 

10. Exporting Files

Sonic Visualiser files can be exported out and saved as images or audio files. 

10.1 Image File 

To export out an image of a spectrogram in .png format for printing, use in documentation, or 
virtual display. 

Go to File >> Export Image File. Name and Save the file to the computer or drive. A dialog 
box will appear containing options for exporting: 
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- Export the whole pane: this will export out an image of the entire spectrogram, even if the
image has been zoomed in on

- Export the visible pan area only: this will export out an image of the area visible in the pane
on screen only, i.e., the area zoomed in on

The Property Boxes/Tabs and Zoom Wheels may appear in the exported image. To hide the 
Property Boxes and Tabs from view, go to View Menu >> Show Property Boxes 
(Shortcut: press X key).  

To hide the Zoom Wheels from view, go to View Menu >> Show Zoom Wheels    
(Shortcut: press Z key). 

10.2 Audio File 

Audio recorded directly into Sonic Visualiser may be exported out and saved as an audio file 
in .wav format (only).  

Go to File >> Export Audio File. Name and Save the file to the computer or drive. 

~ ~ ~

Frequently Asked Questions (FAQs) 

How do I read my spectrogram?  

Spectrograms are like graphs, displaying details about the audio file on and X and Y axis. The 
X-axis displays duration of time in seconds and milliseconds. The Y-axis displays frequencies or
pitches in Hertz frequency values. This greater the value, the higher the pitch, e.g., 440Hz
equates to the pitch A above middle C on a piano keyboard. The intensity of colour or
brightness of display indicates areas of greater amplitude or resonance within the sound.
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The audio files that I want to convert to a spectrogram is a little noisy. Can I fix it?

It is recommended that you record audio with the highest quality possible as it is difficult to remove all noise 
once captured. However, if you have access to audio editing software such as Audacity (freeware), WavePad 
(free edition), AudioDirector (online) or other free audio software, you can open the audio file and minimise 
the noise. 

If you do not have access to this type of software, you can still use the audio file and convert it to a 
spectrogram in Sonic Visualiser and make allowances for noise that will be depicted on the image. See 
examples below: 

Spectrogram recorded without USB microphone. 
Noise from the computer causes a visible line 
across the top of the spectrogram and a grainy 
image. However, spectrographic detail is still 
visible. 

Spectrogram recorded with a USB microphone. 
The image is sharper, and the spectrographic 
detail is clearer. 

The spectrographic detail in the first image is still apparent even though the image is somewhat grainy. For 
best results, it is recommended that a USB microphone be used when demonstrating concepts and 
interacting with spectrograms in a live context, e.g., online, in a large teaching room, a studio or rehearsal 
space. 
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I want to place two spectrograms side by side for comparison purposes.             
How do I do this? 

There are two ways you can compare spectrograms: 

1. You can open both audio files and convert them to spectrograms in separate panes on
screen. Open the first audio file as an audio waveform in Sonic Visualiser and convert it to a
spectrogram. Then go to the File Menu >> Import More Audio and the second audio
waveform will appear in a separate window. Convert this to a spectrogram.

2. You can import both audio files into audio editing software such as Audacity and copy both
audio files onto one track, leaving a little space in between them. Export them out as a new
audio waveform file, then open this and convert it to a spectrogram in Sonic Visualiser. This is
a better option if you are using a smaller screen and don’t want to reduce the size of the
spectrogram by splitting the screen into two panes. This option also works well when
comparing very short audio extracts.

Getting Started with Spectrograms 

Designed & produced by: Dr Barbara Dignam 
Copyright: Dublin City University, 2023 

This user guide has been designed and produced as a resource for the Visualising Vocal 
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